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         PowerPoint Presentation  

(Advanced Features) 

PART II 

 
Objectives 

In part I, we have discussed the basic features of PowerPoint Presentation and  In this part(II), 

we will discuss the Advanced Features of PowerPoint such as: 

 Use of action buttons, slide master, handout master, notes master  

 How to customizing slide show, hiding slides, recording narration, rehearsing presentation and 

estimating timings  

 Show Markup  and adding comments 

 How to Protect a Presentation and 

 Package the presentation for a CD  

 

1. Action Buttons 
Action buttons are built-in button shapes (located in the Shapes gallery) that we can add to our 

presentation. We can also assign actions to pictures, or to the text in a SmartArt graphic. The idea is that 

when we deliver our presentation, we can click or mouse over an action button to:  

 Go to the next slide, the previous slide, the first slide, the last slide, the most recent slide 

viewed, a specific slide number, a different Microsoft Office PowerPoint presentation, or a Web 

page. 

 Run a program 

 Run a macro 

 Play an audio clip and video 

Actions buttons can be found or added from three different areas of the PowerPoint ribbon:  

A. From Home Tab - In the drawing area of Home tab, on the left side of the Drawing area we will 

find a large list of readymade shapes. Use the scroll arrow to move to the bottom of the list of 

objects where we will find the list of Action Buttons (outlines in orange in the image below). 

 
B. From Insert Tab - In the Illustrations area of the Insert tab we will find a button named Shapes. 

Click on the button to see a large list of shapes (truncated in the image below). The bottom row 

of shapes is where we will find the Action Buttons. 



 
C. Insert Tab - A shape, image, or selected text can be associated with an action. After using one of 

the pre-drawn Action Buttons from one of the two areas (Home tab, Illustrations group under 

Insert tab), experiment by associating an action with some other object on a slide. Action button 

can also be located in the Links area under Insert Tab. This following two buttons will active 

unless an object is selected. 

 

To add an Action Button and assign an action, For example: 

 Step 1- Select the button which has a triangle pointing to the right. After selecting an action 

button, our mouse cursor turns into a cross hair shape, keep the mouse button depressed on 

the slide, and then drag down and draw a button to the right, it indicates Forward or Next. 

 
 

 Step 2 - As soon as finish drawing the button (by letting go of the mouse button) an Action 

Settings pop-up window will be displayed. If we have selected the Forward or Next button, the 

default setting will be to go to the next slide by mouse click. Click OK to accept this setting. From 

the settings window below, we could select Mouse Over, or click on the down arrow in the Next 

Slide box and choose another action. For this show, select the default setting. 



 
 

 Step 3 - Select slide Two. Repeat the procedure to create a button to the next slide. Make this 

button act also on a mouse click, just like the first one made. Also create a button in the bottom 

left corner of slide Two to go back to the first slide. For this button, select the Mouse Over tab. 

Even though we have chosen the Back button, we must select Previous Slide from the pull down 

menu. 

 
 

Similarly we can insert URL. A Hyperlink to URL dialog box pops up. Paste, or type a URL into 

the box, then click OK. On clicking the object during slide show, the hyperlinked file and URL 

to a web page will be popped up in a separate screen. 



 

 

 

2. Slide Master  

The easiest way to make the same change to all slides or slides that use a specific layout is to 

change the slide master, also called the master slide. For example, we may like to add a 

background colour theme to all the slides in a PowerPoint file or we may want a different bullet 

style, slide titles that are center-aligned instead of left-aligned, or an accent line under each slide 

title.  

To view the slide master, select the View tab; click the Slide Master View command in the 

Presentation Views group. Select the slide master for all slides, if it is not currently selected. 

 
 



From the Slide Master tab, in the Close group, click CLOSE MASTER VIEW. The changes 

will appear on all slides in the presentation. Then view the presentation in Slide Show view to 

see the changes. 

 

3. Handout Master 

We can use the Handout Master in PowerPoint to set the appearance of the printed handouts for a 

presentation including the layout, headers and footers, and background. To access this view, 

click the “Handout Master” button in the “Master Views” button group (“Presentation Views” 

button group in 2007) on the “View” tab in the Ribbon. This will then display the handout master 

for the presentation in the main window. We will also see the “Handout Master” tab appear in 

the Ribbon. Customizing of layout can be done by using settings on all three menus—Handout 

Orientation, Slide Size, and Slides per Page.  We can adjust headers and footers, date in 

the Placeholders group and also edit theme, change background styles, fonts, and colour of text 

using the Handout master tool. 

 
4. Notes Master 

The Notes Master in PowerPoint helps to alter the appearance of the “Notes Page” view of 

presentation slides. The Notes Master contains two main placeholders: one for notes text and the 

other for the slide. We can move or change the size of either of these objects, and can change the 

format of the text in the notes placeholder. We can add or change elements that we want to 

appear on each handout page, also notice the convenient placement of the header, footer, date, 

and page number blocks. 

 

 The  Notes Master tab is found under View tab and on clicking it will appear in the Ribbon. 

 Once we have finished altering notes master in PowerPoint, click the “Close Master View” 

button in the “Close” button group on the “Notes Master” tab to close the view. 

 



 
 

 

5. Slide Show 

A single screen of information, that able to display text, charts, and images and many more. A 

slide can also feature various transitions, which are added effects to enhance the slide and 

provide different viewing styles, often displayed on a large screen using a video projector.  

 

 
 

The short key for slide show is [F5] , by pressing F5 will start from the first slide. 

Under the Slide Show tab, in the Start Slide Show group, choose from one of the following 

options: 

 On clicking From Beginning to start the show from the first slide. 

 On clicking From Current Slide to start from the slide that is active. 

 On clicking Custom Slide Show, Custom Shows dialog box will open. Then click on 

New and  choose the slides that may use in the show and the order. 



 
 

 Set Up Slide Show 

 The default settings for showing a PowerPoint presentation are usually enough. But 

 PowerPoint has some advance options for customizing PowerPoint shows manually and 

 even more. Clicking Set Up Slide Show in the Set Up group, the Set Up Show dialog 

box will  open. The following is the default Set up Slide Show. 

 
 

With the options on the Set up Show dialog box, we can do the following: 
 Choose the show type: 

 Click the Presented by a speaker option to run a full screen slide show.  

 Click the Browsed by an individual option to run a slide show in a window. 

 Click the Browsed at a kiosk option to create a self-running show. 

 Select or clear:  



 Loop continuously until 'Esc' option to run the show until we press Esc.  

 Show without narration option to skip narrations.  

 Show without animation option to skip animations. 

 Select pen color: Select the color to use for the pen. 

 Select slides: In the Show Slides area, select All to include all slides or choose From and 

supply starting and ending slide numbers to display only selected slides. 

 Set up custom shows: Choose Custom Show if there is any custom shows within the 

presentation. 

 Choose to change slides manually: Choose Manually to advance from slide to slide by 

pressing Enter or clicking. To set the show to proceed automatically, select the Using 

Timings, If Present. 

 Select a monitor: Select which monitor to use from the drop-down list in the Multiple 

Monitors area. 

 Set performance options: Enable or disable graphics acceleration features. Check the 

Use hardware graphics acceleration option unless presentation isn’t working properly. 

 Slide show resolution: Click the Slide show list arrow, and then select the display 

resolution. 

 

6. Hide Slide 

There are two ways by which we can hide a slide during a presentation 

Step 1:  In the pane that contains the Outline and Slides tabs, right-click the slide and then click 

Hide Slide. 

 
Step 2:  Select the Slide Show tab. Then click the Hide Slide command. 

 
 

 

 



 

Click the Hide Slide command again to display the slide. 

7. Record Narration 

Adding narration to PowerPoint presentations is easier than it sounds. We can record our voice to 

narrate our slide show and then link to or embed the sound file to our presentation.  

 When we embed a narration, the narration sound file becomes part of the presentation and 

travels with it, resulting in a larger file size for the presentation. 

 When we link a narration, the file size of the presentation is smaller, because the sound file is 

stored outside the presentation. We have to specify a location on our hard disk drive for the 

narration, and the sound file plays with the presentation. If we give the presentation on a 

different computer, we must move the linked sound file to that computer. The best way to 

move a presentation and its linked files is to use the Package for CD feature. 

When we record the narration, we run through the presentation and record on each slide. 

PowerPoint stores slide files separately so the slides are synchronized with the narrations we 

recorded. To record and hear a narration, our computer must be equipped with a sound card, 

microphone, and speakers. To record a narration, go to the first slide of the presentation and then 

follow these steps: 

 

 Step 1: Open the Slide Show tab and then click the Record Narration button in the Set Up 

group. The Record Narration dialog box informs us how much hard drive space we have and 

calculates the maximum length of the narration that we can record. 

 
 Step 2: Click the Set Microphone Level button.  The Microphone Check dialog box opens. Talk 

into the microphone. PowerPoint adjusts the microphone sensitivity. When it finished, click OK 

to begin the slide show. The first slide of our presentation displays. 

 
8. Rehearsing Timings 

Rehearsing timings can be useful if we want to set up a presentation to play at a certain speed without 

having to click through the slides to present it. Using this feature, we can save timings for each slide and 

animation. PowerPoint will then play back the presentation with the same timings when we present it. 



To rehearse timings: 

 Select the Slide Show tab, then locate the Set Up group. 

 Click the Rehearse Timings command. It will take us to a full-screen view of the 

presentation along with Rehearsal recording toolbar at the top-left corner. 

 To move to the next slide, click the Next button,  or use the right arrow key. 

 
When we reached the end of the show, a dialog box will appear with the total time of our 

presentation. If it is satisfied with our timings, click Yes. 

 
If we need more than one try to get the timings just right, the recording toolbar has options to let 

us to take a break or start over on a slide. To pause the timer, click the pause button on the 

toolbar. To re-record the timings on the current slide, click the repeat button. 
9. Show Markup  

The Show Markup option under Review tab allows to add, edit, delete comments and see existing 

comments. A comment is a note that can attach to a letter or word on a slide, or to a whole slide. Use 

comments while reviewing and providing feedback on a presentation or when colleagues ask for 

feedback on a presentation. 

 

 
 

10. Protect Presentation  
 This is another interesting functionality under this Review tab that makes it possible to protect 

the entire document and restrict access based on credentials. It is useful to share sensitive 

information inside a PowerPoint presentation. 

 

 



 

11. Package the presentation for a CD 
Sometimes we need to share a PowerPoint presentation with someone who doesn’t own a copy of 

PowerPoint. Fortunately, PowerPoint includes Package the presentation for a CD command that creates 

a CD with our presentation and a special program called the PowerPoint Viewer. 

 

To create a CD with a presentation, follow these steps: 

 

Step 1: In PowerPoint 2007, click the Microsoft Office Button, point to Publish, and then click Package 

for CD. The Package for CD dialog box will appear on the screen. 

 

Step 2: Click Options. The Options dialog box opens. 

Step3: Change options settings. The options that are available are: 

 Viewer Package: Make a Self-Running Package (update file format) - Creates a CD that 

automatically plays the presentation when the CD is inserted into a computer. 

 Active Package: Make a package by using original file formats (or do not update file 

format)-Instructs the Package to CD Wizard to copy the presentation files to CD. 

 Linked Files: Select this option to include any linked video or audio files. 

 Embedded TrueType Fonts: Ensures that the fonts use in the presentation are on 

another computer. 

 Password to Open Each Presentation: Require a password if the presentation contains 

top-secret information. 

 Password to Modify Each Presentation: Require a password to prevent unauthorized 

people from changing the presentation. 

 Inspect Presentations for Inappropriate or Private Information: Checks for any 

personal information that might be embedded in the presentation. 

 



 

 

Click OK to return to the Package to CD dialog box. For adding other presentations to the CD, 

just click Add Files, select the files from the computer, and then click Add. Finally click Copy 

to CD. Insert a blank CD into the drive when prompted. Remove the CD and then click Yes to 

make another copy. Otherwise, click No and then click Close. 

Summary 

In the part of we have discussed the different advanced Features such as action buttons, slide 

master, handout master, notes master, slide show, set up slide show, hide slide, record narration, 

rehearse timings. Also discussed show markup by adding comments, protect presentation and 

package the presentation for a CD. 

 
 

 


